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Understanding the Structure of a CMS
Before embarking on restyling a WordPress site, it’s worth spending a few moments exam-
ining how a CMS like WordPress, Drupal, or Joomla! is structured. A bare-bones Drupal 
installation consists of more than 460 files in 58 folders; WordPress has nearly 800 files in 
79 folders; and Joomla! weighs in at a whopping 3,913 files in 711 folders. Unlike a website 
built with HTML, these files don’t contain any of the site’s content. In fact, the only page that 
most users ever see is index.php.

With the exception of images and other media files, all the content is stored in a database. 
The job of the army of files is to insert, update, and delete content in the database, and to 
serve visitors to the site with the information they want to see. If you open index.php in any 
of the CMSs, you see just a handful of PHP commands. There’s nothing recognizable as a web 
page. Each part of the final web page is generated separately. Different scripts handle the page 
header, menus, main content, and footer.

This mass of files can be intimidating, even if you have a good understanding of PHP. As a 
result, many designers opt for using third-party themes (or templates, as Joomla! calls them) 
to improve the look of their CMS. There are plenty of good themes and templates available, 
and the default Twenty Ten theme in WordPress 3.0 is very attractive. But with the help of 
Dreamweaver CS5, it’s not difficult to do your own customization—providing you have a 
strong grasp of CSS.

With a CMS, it’s important to apply security fixes as soon as they’re released, so you need to 
install your custom files in a place where they won’t be overwritten. The location depends on 
the CMS you’re using:

Drupal. Create two subfolders called modules and themes in sites/all. The themes folder 
is where you install third-party themes or create your own.

Joomla! Create a subfolder in the templates folder.

WordPress. Create a subfolder in wp-content/themes.

Although the instructions in this lesson concentrate on creating a WordPress theme, the same 
principles of editing the CSS apply to Drupal and Joomla!

 TIP: There’s a tutorial by David Karlins on modifying Drupal themes with Dreamweaver CS5 at 

www.peachpit.com/articles/article.aspx?p=1590589.
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Installing WordPress
The following instructions assume you have created a PHP local testing environment as 
described in Lesson 2, and that your web server and MySQL are running.

Setting up a MySQL database and user account
Before you can install WordPress, you need to create a MySQL database and user account. 
Both subjects are covered in greater detail in Lesson 5, but the following steps guide you 
through the process of setting up a WordPress database.

 Load phpMyAdmin in your browser, and log in as the root user if necessary.

 In the “MySQL localhost” section in the center of the screen type wordpress in the 
“Create new database” text field. Leave all other settings at their default, and click Create.

You should see a message that the database has been created. You don’t need to create any 
tables. WordPress does it for you.

 Click the Home icon  at the top left of the phpMyAdmin screen to return to the previ-
ous page. Then click the Privileges tab at the top of the screen.

CAUTION! Don’t be tempted to click the Privileges tab on the previous screen. You must return 

to the phpMyAdmin welcome page to access the correct screen.

 Click the “Add a new User” link halfway down the screen.

 In the “Add a new User” section, type wpuser in the “User name” field.

 Select Local from the Host menu to insert localhost in the Host field.

 Type P3@chp!T in the Password field, and again in the Re-type field.
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 Scroll to the bottom of the page, and click Go.

phpMyAdmin reports that it has created the user and displays a page where you can edit 
the user’s privileges. The first section, “Global privileges,” gives the user the same privi-
leges on all databases, which is insecure.

 Scroll down to “Database-specific privileges” and select wordpress from the menu 
labeled “Add privileges on the following database.”

This loads a new screen where you define the database-specific privileges. 

 You need to select all checkboxes except the three in the Administration box. The quick-
est way is to click “Check all,” and then deselect the three Administration checkboxes.

 Click the Go button in the “Database-specific privileges” section.

CAUTION! There are two Go buttons on this page. Make sure you click the top one.

You should see a message saying you have updated the privileges for ‘wpuser’@’localhost’. 
You’re now ready to install WordPress.

LESSON : Restyling a WordPress Site

Lesson 4. Restyling a WordPress Site. Adobe® Dreamweaver® CS5 with PHP: Training from the Source, ISBN: 9780132117906
Prepared for jednet@mac.com, john gibbs
Copyright © 2011 David Powers. This download file is made available for personal use only and is subject to the Terms of Service. Any other use requires prior written consent from the
copyright owner. Unauthorized use, reproduction and/or distribution are strictly prohibited and violate applicable laws. All rights reserved.



115

Adding WordPress to the phpcs5 site
Installing WordPress involves unzipping the files into the folder where you want to locate the 
CMS. This can be the site root or a subfolder. For this lesson, use a subfolder of the phpcs5 site 
you set up in Lesson 2. After extracting the files, you need to edit a configuration file filling in 
the details of the MySQL database. The rest of the installation process is automated.

 Use lesson04/start/wordpress-3.0.zip or download the most recent version of WordPress 
from http://wordpress.org/.

 Extract the files to the phpcs5 site root. This should create a folder called wordpress 
inside the phpcs5 site. The folder contains about 25 files and three subfolders: wp-admin, 
wp-content, and wp-includes.

 Click the Refresh icon  in the Dreamweaver Files panel to see the newly added folders 
and files.

 Double-click wp-config-sample.php in the wordpress folder to open it in the Document 
window, and switch to Code view.
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The first part of the script (around lines 18–34) defines the MySQL settings for the CMS. 
Replace the placeholder text in the first three lines with the name of the database, the user 
name, and password that you created in the previous section like this:

 Scroll down to around line 45 to the following section of code:

This defines a series of measures designed to make it extremely difficult, if not impossible, 
for anyone to reuse cookies if the security of your site is breached. When creating your own 
WordPress site, you can use your own imagination to create unique character sequences, or 
you can use the automatic key generator at https://api.wordpress.org/secret-key/1.1/salt/.

For this lesson, use the values in lesson04/start/auth_keys.txt to replace the eight lines 
shown here.

NOTE: In the event that the security of a live WordPress site is breached, you should replace 

these eight values and update the file on your remote server immediately.

 Save wp-config-sample.php as wp-config.php, and close both files.

 Launch your browser, and open wordpress/wp-admin/install.php in your phpcs5 site. 
The URL depends on how you set up your testing environment:

Virtual host. http://phpcs5/wordpress/wp-admin/install.php

Localhost. http://localhost/phpcs5/wordpress/wp-admin/install.php
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NOTE: If you are using the MAMP default ports on a Mac, add :8888 after phpcs5 for a virtual 

host, or after localhost.

 The install page asks for some basic information to set up the site. Type Birds of a 
Feather in the Site Title field.

 Leave username at the default admin.

 Type C0rm0R@nT in both Password fields.

 For a live site, you should use a real email address in Your E-mail, because it’s used to 
send alerts about posts waiting for approval. It’s also used if you forget your password. 
A dummy address is fine for testing.

 Deselect the checkbox that allows your site to appear in search engines like Google and 
Technorati. You won’t be deploying this exercise on the Internet.

 Click Install WordPress. In a few moments, you’ll see a screen telling you that WordPress 
has been installed and inviting you to log in as admin.

 Click Log In to open the login screen. Type admin in the Username field and C0rm0R@nT
in the Password field. It’s also a good idea to select the Remember Me checkbox to avoid the 
need to type these details every time.

 Click Log In to enter the WordPress Dashboard, the administration center for a 
WordPress site.
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 Click the name of the site (Birds of a Feather) next to the WordPress logo at the top of the 
page to view the front page.

Why Can’t I See the Multiscreen Button?

The screen shot on the next page shows a Multiscreen button in the Document tool-
bar, which isn’t part of a default installation of Dreamweaver CS5. It comes from the 
HTML5 Pack that was released in May 2010, a month after Dreamweaver CS5 became 
available for purchase. Although the Multiscreen button isn’t used in this book, the 
HTML5 Pack upgrades the version of the WebKit browser engine used in Live View to 
support CSS3 properties that are used later in this lesson.

If you don’t see the Multiscreen button, check the status of the HTML5 Pack at 
http://labs.adobe.com/technologies/html5pack/. It’s possible that during the lifetime 
of this book the pack’s functionality will be added to Dreamweaver through the Adobe 
Updater. Download and install the HTML5 Pack using whichever method is available. 
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 In Dreamweaver, double-click index.php in the wordpress folder to open it in the 
Document window. In Code view, there are just two lines of PHP code, together with a 
dozen or so lines of comments.

Switch to Design view, and click the Live View button. After a few moments, you should 
see the Birds of a Feather site in the Dreamweaver Document window. There are several 
files called index.php in a WordPress site. If you don’t see the front page of the Birds of a 
Feather site in Live View, make sure you opened index.php in the top wordpress folder.

The default Twenty Ten theme in WordPress 3.0 has been designed to look good straight out 
of the box. But with the help of Dreamweaver CS5’s new features, you’ll learn how to develop 
your own theme to style WordPress.

Creating a WordPress Theme
Developing a WordPress theme from scratch requires considerable knowledge of CSS, HTML, 
PHP, and the WordPress application programming interface (API). The good news is that you 
can stand on the shoulders of others to adapt an existing theme as a child theme.

Child themes work on a similar principle to CSS. The child theme automatically inherits all 
the features of the existing theme, but you can decide which elements to override. The advan-
tage is that the original files remain intact, so you can revert to the default if you change your 
mind or make a mistake. Also, if the parent theme is updated, you can replace all its files with-
out worrying about losing your customizations because they’re all stored in the child theme.
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Most themes can be adapted as child themes. Before doing so, check the license. Some com-
mercial themes have restrictions on how they can be used. The Twenty Ten theme used in the 
following exercises is released under the GNU General Public License (www.gnu.org/licenses/
gpl.html), which means you are free to modify and redistribute it.

Preparing the files for a child theme
Themes consist of at least one style sheet and a number of WordPress templates. A WordPress 
template doesn’t control a complete page. It’s more like a Dreamweaver Library item in that it 
represents a fragment of a page. Each template is named after the part of the page it controls. 
For example, the Twenty Ten theme has templates called comments.php, footer.php, header.
php, sidebar.php, and so on. If you open any of these files, you’ll see a mixture of HTML and 
PHP. If you don’t have any PHP experience, the code probably looks incomprehensible, but 
much of it is based on conditional statements. You’ll gain plenty of experience with condi-
tional statements in later lessons, so the code should be a lot easier to decipher by the time 
you have completed this book.

However, you don’t really need to worry about the PHP code in the templates. A child theme 
requires only one file—a style sheet, which must be called style.css and reside in the child 
theme’s top level folder. The child theme automatically uses the parent theme’s templates 
and custom functions. In other words, at its simplest level, creating a child theme is just the 
WordPress way of attaching your own style sheet to an existing theme. But if you’re feeling 
more ambitious, you can create your own templates and functions. When the active theme is 
a child theme, WordPress always looks first in the child theme’s folder. If it finds the appropri-
ate template or function there, it uses it. Otherwise, it uses the version in the parent theme’s 
folder. For example, if you create your own version of header.php, WordPress uses it. But 
if you don’t have your own version of footer.php, WordPress uses the one from the parent 
theme. This gives you the opportunity to experiment. You can copy a template file from the 
parent theme, and make some changes. If you like the result, you’re on the way to developing 
your own theme. If it doesn’t work, just delete the template file from your child theme’s folder, 
and revert to the parent template.

Developing WordPress themes is a vast subject, so the exercises in this lesson only scratch 
the surface, but they demonstrate how quickly you can begin to style a WordPress site in 
Dreamweaver CS5.

 In the Dreamweaver Files panel, expand the wordpress and wp-content folders, select the 
themes folder, right-click, and choose New Folder. Name the new folder birds_phpcs5.
The new folder should be inside the themes folder at the same level as twentyten.
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 Expand the twentyten folder, and double-click style.css to open it in the Document window.

 The first eight lines of style.css look like this:

This tells WordPress what the theme is called, plus some basic information about the theme.

 Choose File > Save As or press Ctrl+Shift+S/Shift+Cmd+S. In the Save As dialog box, 
navigate to the birds_phpcs5 folder, and save the file with the same name (style.css). 
When asked if you want to update links, click No.

 Close the original style.css, and make sure you’re working in the version in the 
birds_phpcs5 folder. The file path should be visible in the Browser Navigation toolbar.

Alternatively, click the Open Documents icon  at the top of the Coding toolbar to 
reveal the file path.

 The Theme Name comment must contain a unique name, which cannot consist only 
of numbers (that’s why it’s “Twenty Ten,” not “2010”). When creating a child theme, 
you need to specify the parent theme as the child theme’s template. Without these two 
changes, WordPress won’t recognize your child theme. Changes to the remaining com-
ments are optional. Amend the comments at the top of style.css like this:
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The parent is identified by  followed by a colon and its folder name. 

 Save style.css and close it.

 This is sufficient for WordPress to identify the new theme, but it’s a good idea to add an 
image to distinguish it from others in your Dashboard. The image should be about 300 
pixels wide and must be called screenshot.png. Copy screenshot.png from lesson04/start/
images to the birds_phpcs5 folder. The child theme folder should now contain two files.

You’ll add more files later, but that’s sufficient for now.

 TIP: If you create a mockup of your final design in a graphics program, such as Fireworks or 

Photoshop, you can create screenshot.png by scaling the mockup and exporting it as a 

file. If it can’t find screenshot.png, WordPress displays a text description of the theme.

Activating the child theme
The child theme needs to be activated before you can style it in Dreamweaver.

 In your browser, log into the WordPress Dashboard. Depending on how you set up your 
testing environment, the URL should be one of the following:

Virtual host. http://phpcs5/wordpress/wp-admin/

Localhost. http://localhost/phpcs5/wordpress/wp-admin/
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 Expand the Appearance section in the column on the left of the Dashboard, and 
select Themes. The new Birds of a Feather theme should be displayed in the Available 
Themes section.

 Click the Activate link for the Birds of a Feather theme. After a few seconds, Birds of a 
Feather is displayed as the Current Theme and Twenty Ten moves down to the Available 
Themes section.

 Click the Widgets link in the Appearance menu to open the widget settings screen. 
The child theme inherits the default settings of the Twenty Ten theme. You can study 
all the options later. For now, remove the Recent Comments and Meta widgets from 
the Primary Widget Area by dragging them from the sidebar on the right back to the 
Available Widgets area.

 Drag the Categories widget to move it just below the Search widget. The Primary Widget 
Area should now look like this:
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 Click the Background link in the Appearance menu. This allows you to set a background 
image and color for the site. However, it does this by generating a  block in the 
head of the page. It’s better to use style.css to handle this, so leave this screen unchanged.

 Click the Header link in the Appearance menu. This is one of the cleverest parts of the 
new Twenty Ten theme. It offers a choice of eight header images for your site. You can 
also upload your own images. The problem is that if your image isn’t exactly the same size 
as used by Twenty Ten (940 × 198 pixels), you’re prompted to crop it. WordPress doesn’t 
crop your original, but instead makes a copy. If your image’s height is less than 198 pixels, 
it’s stretched. The result is often unsatisfactory.

The height and width of the header images are controlled by a custom function in the 
Twenty Ten theme. To change the default values, you need to override that function. 
Leave your browser open at the current page, and return to Dreamweaver.

 Custom functions for WordPress themes are stored in a file called functions.php. If you 
attempt to redefine an existing function, PHP throws a fatal error, but WordPress over-
comes this problem with a simple conditional statement. All the functions in the parent 
theme’s functions.php file are wrapped in a conditional statement that checks whether a 
function of the same name has already been defined. If it hasn’t, the parent theme defines 
the function. Otherwise, it uses the one defined by the child theme.

Choose File > New. Set Page Type to PHP, set Layout to <none>, and click Create. Switch 
to Code view, and delete all the HTML code inserted by Dreamweaver. You should have a 
completely blank page.

 Add an opening PHP tag at the top of the new page, and save it as functions.php in the 
birds_phpcs5 folder.

 Double-click functions.php in the twentyten folder to open it in the Document window. 
The file contains extensive comments that help you understand what the functions are for 
and how to override them.

 Scroll down to around line 47 to locate the following code:

This defines the width of the main content  in the Twenty Ten theme. As you 
can see, the conditional statement sets the value to 640 (pixels) only if 
hasn’t already been defined. So, to change the width to a different value, you need to add 

 to functions.php in the child theme. Otherwise, this value is used.
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 The header image for Birds of a Feather is 20 pixels wider than the Twenty Ten images, 
so you can expand the content by the same amount.

Switch to the empty functions.php file you created for the child theme, and add the 
following code after the opening PHP tag:

 Switch back to the Twenty Ten version of functions.php, and scroll down to locate the 
following line of code (around line 53):

This conditional statement checks whether a function called  has 
already been defined. If it hasn’t, it creates the function, which—as the name suggests—
defines the default settings for the Twenty Ten theme.

NOTE: This conditional statement ends with a colon rather than an opening curly brace.

This is an alternative syntax for control structures. See http://docs.php.net/manual/en/

control-structures.alternative-syntax.php.

 To create your own default settings for the child theme, you need to copy the function 
definition to the version of functions.php in birds_phpcs5. The function definition begins 
like this (around line 75):

The final section of the function definition looks like this (around lines 171–178):

Select the entire function description, and copy it to your clipboard.
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 Paste the function definition into functions.php in the birds_phpcs5 folder. If you copied 
and pasted the code correctly, Dreamweaver should display “No syntax errors” in the Info 
Bar at the top of the Document window.

 Scroll down to locate this code (around line 35):

This defines the default header image for the Twenty Ten theme (the tree-lined path). 
To display a different image, change the filename like this:

You’ll add this and other images to the relevant folder shortly.

 The next section of code defines the width and height of the header image. Change the 
width from 940 to 960 and the height from 198 to 150 like this:

 About 20 lines farther down is a long section of code that begins like this:

This passes a multidimensional array to , a function new 
to WordPress 3.0, which defines the choice of header images offered by the theme. The 
default Twenty Ten images are all 940 pixels wide and 198 pixels high, so they won’t fit 
the child theme.

The media files for this lesson contain two header images called cormorants.jpg and 
seagulls.jpg, together with two smaller versions called cormorants-thumbnail.jpg and 
seagulls-thumbnail.jpg. Change all instances of berries in the multidimensional array to 
cormorants, and cherryblossom(s) to seagulls. There are only two header images, so you 
need to delete the other six subarrays. When you have finished, the final section of func-
tions.php should look like this:
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 Save functions.php and copy cormorants.jpg, cormorants-thumbnail.jpg, seagulls.jpg, 
and seagulls-thumbnail.jpg from lesson04/start/images to twentyten/images/headers. 
The images must go in the parent theme’s folder because that’s where 

 expects to find them.

 Return to the Header page in the WordPress administrative area. Click the Background 
link in the Appearances menu, and then click Header to reflect the changes you have 
made. The Custom Header section should now display the two Birds of a Feather header 
images, and the text in the Upload Image section should show the new default dimen-
sions of 960 × 150 pixels.

If necessary, compare your code with lesson04/completed/functions.php.
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Styling the child theme
All that remains now is to adjust the styles to give the theme its own look. Most of the remain-
ing tasks are done in Live View and the CSS Styles panel.

 Close functions.php if it’s still open, and create a new folder called images in the 
birds_phpcs5 folder. Copy birds_bg_gradient.jpg from lesson04/start/images to 
the new folder. You’ll use this later as a background image to the new theme.

 Double-click index.php in the main wordpress folder to open it in the Document win-
dow. Switch to Design view if necessary, and click Live View. The Birds of a Feather site 
should display with the new default header and the edited sidebar.

 The header image is now wider than the menu bar. To fix that, click the Inspect button 
in the Document toolbar. As you move your pointer over Live View, you’ll see different 
sections of the page highlighted. The content of an element is light blue or aqua, padding 
is mauve, and margins are yellow.

Notice that as you move from element to element, the currently highlighted element 
is also selected in the Tag selector at the bottom of the Document window. When your 
pointer is over the black menu bar below the header image, you should see 
highlighted in the Tag selector. Click the menu bar to select it.
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 Selecting an element turns off the Inspect button, allowing you to move your pointer 
without highlighting other elements. Open the CSS Styles panel by clicking its tab or by 
choosing Window > CSS Styles. On Windows, you can also use the keyboard shortcut 
Shift+F11 (there is no Mac shortcut).

Make sure the Current button is selected at the top of the CSS Styles panel and that the 
Rules pane is visible in the middle section. If the middle section is titled About, click the 
Cascade icon as indicated in the following screen shot. You might need to close other panels 
and drag the panes inside the CSS Styles panel to see the rules and properties listed.

Click to display the cascade of rules for the selected tag

The Rules pane displays all the style rules that affect the current selection. Sometimes you 
need to examine several rules before finding the right one, but on this occasion, it should be 
the one selected by Dreamweaver. It’s the  rule shown in the preceding screen shot.

Select  in the Rules pane. This reveals that the  property is set to . Click 
the value to edit it, and change the number to 960. The px unit is controlled by a separate 
menu, so you don’t need to change it.
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As soon as you press Enter/Return to confirm the edit, the menu bar in Live View 
expands to match the width of the header image.

 Although the header image and menu bar are now the same length, there’s a gap of about 
20 pixels of white space on the left of both elements. Finding the cause of the gap is a 
process of elimination, but if you look farther down the page, you’ll see there’s a similar 
gap on both sides of the horizontal line above the footer.

Click the Inspect button again, position the pointer over the footer so that the full width 
below the horizontal line is highlighted, and click to select it.

 In the Rules pane of the CSS Styles panel,  is selected. Examining the Properties 
pane reveals nothing to help eliminate the gap on the left and right, so start moving up the 
cascade of rules in the Rules pane. The next property begins with  and 
has a  property of . Change the number to 960 as you did in step 4.

As soon as you press Enter/Return, the white background expands to create the same gap 
on both sides of the header image, menu bar, and the horizontal line above the footer. 
This is progress, but the final design calls for the gap to be eliminated.

 Click  in the Tag selector at the bottom of the Document window 
to reveal its properties in the CSS Styles panel. You’ll see that the  property is 
set to . This adds 20 pixels of padding to both sides of the wrapper .

Remove the padding by selecting it in the Properties pane of the CSS Styles panel and 
clicking the trash can icon at the bottom right of the panel.

The left and right sides of the heading image, menu bar, and horizontal line above the 
footer are now flush with the white background of the wrapper.

 There’s a large gap between the white background and the top of the page. It’s caused by 
the  property, which is set to . Select  in the Properties pane for 

 and click the trash can icon to delete it.

The entire contents of the page move up to eliminate the gap, leaving the white back-
ground flush with the top of the Document window.

 With  still selected in the Rules pane of the CSS Styles panel, change the 
 property from  (white) to #FAF2EF (light pink).
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 TIP: Hexadecimal values for colors are case insensitive. The Twenty Ten style sheet uses a 

mixture of uppercase and lowercase, indicating that it’s almost certainly the work of more than 

one person. Color values can also be shortened to three characters if each even character is the 

same as the preceding odd one. Thus,  can be shortened to , but  cannot 

be shortened.

 The next step is to change the background of the whole page. Begin by selecting 
 in the Tag selector. The Rules pane selects the 

style rule, which covers too many elements, so start moving up the list of rules. The next 
one, , defines the  property, which is the one you need to change.

The  shorthand CSS property is difficult to define directly in the Properties 
pane of the CSS Styles panel, so select the property and click the Edit Rule icon at the 
bottom right of the panel to open the CSS Rule Definition dialog box.

 The CSS Rule Definition dialog box should automatically select the Background category.

Change the value of Background-color from  to #E1DFE0.

Click the Browse button next to the Background-image text box, navigate to the 
birds_phpcs5/images folder, and select birds_bg_gradient.jpg.

Set the Background-repeat menu to repeat-x.

When you click OK, the page background should change from light oatmeal to a vertical 
gradient that fades from light purple to a light gray.

 Now comes a little bit of CSS magic—swapping the sidebar from right to left. The default 
style rule for the sidebar floats it to the right in a margin created by the main content. You 
can move the sidebar to the other side of the page by floating it left and giving it a large 
enough negative left margin to sit on the opposite side of the main content. But first, you 
need to adjust the margins of the main content.

Click the Inspect button and select the main content on the left of the page. The style 
rule that controls its margins is applied to the container , so click 
in the Tag selector at the bottom of the Document window. The Properties pane of the 
CSS Styles panel reveals that its  property is set to . In other words, 
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a space of 240 pixels has been created on the right for the sidebar. You need to move the 
space to the opposite side. Change the margin property to 0 0 0 240px. This moves the 
main content to the right of the page, but pushes the sidebar below it.

 TIP: The Twenty Ten style sheet’s use of a negative right margin on the container  is 

rather unconventional. It’s needed because the  property of the  is set to .

Using a negative value reduces the width and makes room for the sidebar. If you need to brush 

up on your knowledge of CSS, take a look at my book, Getting StartED with CSS (friends of 

ED, 2009, ISBN: 978-1-4302-2543-0).

 Click the Inspect button again, and move your pointer until the whole of the sidebar is 
highlighted. Then select it. This selects  in the Tag selector. The rule that you 
want to edit is the next one up the page hierarchy. Click 
in the Tag selector.

The Properties pane of the CSS Styles panel displays no styles, so move up the cascade 
in the Rules pane. The next one— —displays the rules that you 
need to change.

 Change the value of  from right to left. The sidebar jumps to the left of the page but 
still below the main content.

 Click Add Property, type margin-left, and set the value to -1180px. (That’s minus
1180 pixels.) The sidebar is after the main content in the underlying HTML markup, but 
a combination of the left float and the large negative margin allows it to leapfrog over the 
main content and move into the correct position in the margin on the left.

 Let’s add a touch of CSS3 coolness to the main content. Click the Inspect button, 
move the pointer over the main content until it’s highlighted, and click to select it. 
The Tag selector shows you have selected 

. Whew! That’s a complex CSS selector. Fortunately, 
the Rules pane selects the lowest part of the cascade, the style rule for the  class, 
which currently sets only the  property.
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Although you could add the next set of CSS properties through the CSS Styles panel, it’s 
a lot easier to work directly in the style sheet. The problem is that the style sheet contains 
more than 1,000 lines. A quick way to locate the correct rule is to use the Code Navigator. 

Hold down the Alt key on Windows or Cmd+Opt on a Mac, and click anywhere in the 
“Welcome to WordPress” default post to invoke the Code Navigator, a context-sensitive 
tool for investigating styles that affect the area you clicked. Many rules affect this area, 
but you should find  listed near the bottom of the panel, as shown in the follow-
ing screen shot.

Click the  link in the Code Navigator to open the style sheet in Split view. Using 
this technique positions the insertion point directly inside the  style rule.

 Amend the style rule like this:
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The properties beginning with  and  are browser-specific implementations of 
the CSS3  and  properties. Putting the properties in this order 
ensures that the effects will be maintained when the official properties are implemented 
by browsers.

If you refresh Live View by pressing F5 or clicking anywhere in Live View, you’ll see 
the post now has a white background with rounded corners. In the Mac version of 
Dreamweaver, you’ll also see a drop shadow as shown in the following screen shot.

NOTE: The Windows version of Live View fails to render the drop shadow correctly. However, 

if you view the finished WordPress site in a recent version of Safari, Google Chrome, or Firefox, 

the drop shadow is rendered correctly on both Windows and Mac OS X. Internet Explorer 8 and 

earlier ignores the CSS3 properties and just displays a rectangular white background.

 Save style.css.

Hopefully, by now you’ve got the picture. You use the Inspect button or Code Navigator in 
Live View to identify elements on the page and inspect the style rules that govern their dis-
play. The Tag selector at the bottom of the Document window shows you where the element 
resides in the document hierarchy. Most CSS properties are inherited, so you often need to 
go back up the hierarchy to find the element where a specific rule has been applied. The CSS 
Styles panel in Current mode also allows you to work back up the cascade of rules affecting 
the selected element.

Styling a web page requires patience and skill. If you have a good command of CSS, you’ll 
find working in Live View with these tools make styling WordPress, Joomla!, or Drupal 
very similar to working with a static HTML page. This lesson has concentrated on styling 
the front page of a WordPress site, but Live View is navigable in Dreamweaver CS5. Just 
hold down Ctrl/Cmd while clicking a link, and you can inspect and style all pages and views 
within a CMS.

To round out this lesson, let’s take a look at a WordPress template and make a slight change so 
that the text heading can be hidden from visual browsers. When editing CMS templates it’s a 
good idea to set up site-specific code hints.
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Enabling site-specific code hints for WordPress, Drupal, and Joomla! 
WordPress, Drupal, and Joomla! use many custom functions to generate the content for each page. 
For example, WordPress provides the  function (http://codex.wordpress.org/Template_
Tags/bloginfo) to display information about your site. Dreamweaver uses code introspection to 
generate hints for your chosen CMS, speeding up editing page templates or functions.

The following instructions show how to enable site-specific code hints for WordPress in the 
phpcs5 site. The procedure is identical for Drupal and Joomla!

 Make sure that the phpcs5 site is selected in the Files panel, and that the active document 
is from the same site or that all documents are closed.

 Choose Site > Site-Specific Code Hints. As long as you haven’t previously set up site-
specific code hints for the same site, the Site-Specific Code Hints dialog box automatically 
recognizes not only which CMS is installed, but also the correct folder.

 All that’s necessary is to check that the Sub-root text field points to the folder that con-
tains the top level of the CMS. If it doesn’t, click the folder icon next to the Sub-root text 
field, and select the correct folder.

 After checking the Sub-root text field, just click OK. That’s all there is to it.

 Dreamweaver inserts a file called dw_php_codehinting.config into the site root and 
automatically cloaks it to prevent it from being uploaded to your remote server when 
you use site synchronization to update your files. This file is used only in your local 
development environment.
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Editing a WordPress page template
The first time you dive into a WordPress template can be a baffling experience, but the Twenty 
Ten theme is well commented. If you understand the HTML structure of the template you’re 
working with, it’s not too difficult to work out where to add custom features, such as a static 
paragraph, or remove elements that you don’t want. As long as you make the changes to a 
template in a child theme, you can always delete the template and use the parent theme’s 
default version if you make a mistake.

 Open index.php in the top-level wordpress folder and click Live View to display the front 
page of the Birds of a Feather site.

 Click Live Code to display in Split view the underlying HTML output generated by 
WordPress. Adjust Split view so you can see the code and “Just another WordPress site” 
at the top right of the page (you might need to scroll horizontally in Live View).

 Click between the words “Just” and “another” in Live View. Depending on the size of your 
monitor, this should scroll Code view so that the equivalent HTML output is in the center 
with the insertion point between the two words, as shown on line 24 in the following 
screen shot:

You can’t edit the output in Live Code, because it’s dynamically generated by WordPress, 
but inspecting the output here gives you a good idea of what to look for when you open 
the WordPress template.

The text you clicked is in a  that has the ID . You can also see on 
line 19 that the main heading has the ID , and that the text is wrapped in a 
link that returns to the front page of the WordPress section of the site.

The final point to notice is that the  attribute of the header image on line 26 is empty. 
The HTML specification requires all images to have alternative text (in the  attribute), 
but it’s recommended to use an empty string when the image is purely decorative. This 
redesign incorporates text into the image, so the same text should be inserted into the 
attribute in case the image is not displayed for any reason.
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 In the Files panel, double-click twentyten/header.php to open it in the Document win-
dow. Save the file as header.php in the birds_phpcs5 folder, and click No when asked if 
you want to update the links. Close the original version of header.php. You want to edit 
the copy in the child theme.

 Scroll down to locate the following (it should be around line 54):

This uses the WordPress  function to display the site description (“Just another 
WordPress site”).

 Delete the entire line, and save header.php.

 Switch back to index.php, and press F5 or click the Refresh icon  in the Document tool-
bar (not the Files panel) to update Live View. After a few moments, the text disappears from 
the top right of the page, and the corresponding code is removed from Live Code.

 Switch back to header.php, and examine the code immediately above the line that you 
removed in step 6. It looks like this:

This code checks whether the current page is the site root or the front page of the 
WordPress section. If it is one of these,  creates a pair of  tags. 
Otherwise, it creates a . It then creates a link to the front page of the WordPress site, 
which is wrapped around the site name.

 The site name is already in the header image, so you don’t want it displayed twice. 
However, you should leave it in the underlying code for search engines and screen read-
ers for the blind. Edit the code like this to remove the link and  tags:

 Save header.php, and refresh Live View in index.php. The text heading is still there, 
but it’s no longer a link.

Creating a WordPress Theme

Lesson 4. Restyling a WordPress Site. Adobe® Dreamweaver® CS5 with PHP: Training from the Source, ISBN: 9780132117906
Prepared for jednet@mac.com, john gibbs
Copyright © 2011 David Powers. This download file is made available for personal use only and is subject to the Terms of Service. Any other use requires prior written consent from the
copyright owner. Unauthorized use, reproduction and/or distribution are strictly prohibited and violate applicable laws. All rights reserved.



138

 Click the Inspect button, select the Birds of a Feather text in Live View, and open the CSS 
Styles panel in Current mode. In the Rules pane,  should be automatically 
selected. You know this is the style rule you want to change, because it’s the ID selector 
for the element you just edited in header.php.

 Select each of the properties in turn and click the trash can icon at the bottom right of the 
CSS Styles panel to delete them. Then click Add Property to add the  property, 
and set it to .

Click Add Property again to add the  property, and set it to  (minus 1000). 
The heading disappears from visual browsers but remains accessible to search engines 
and screen readers.

 There’s still a large gap at the top of the page, so click the Inspect button again, and select 
the area above the header image.

The  rule is selected in the CSS Styles panel. Delete the  property to 
remove the gap.

 Click the header image in Live View to select the  style rule, and delete the 
 property to remove the thick black border at the top of the page.

Save style.css to preserve the changes.

 Return to header.php, and locate the following code, which inserts the header image 
(around line 63):

You could hard code the value of the  attribute, but that would mean changing the 
template if you decide to use the same theme for different sites. It makes more sense to 
use the WordPress API.
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Position the insertion point between the quotation marks of the  attribute, type an 
opening PHP tag followed by a space, and then press Ctrl+spacebar to bring up code 
hints. Type bl. Dreamweaver should select .

Press Enter/Return to autocomplete the function name. Dreamweaver automatically 
inserts the opening parenthesis. Complete the code by typing ‘name’ followed by a clos-
ing parenthesis, semicolon, and closing PHP tag. The  attribute should look like this:

 Save header.php, and refresh Live View in index.php. When Live Code reloads, you 
should see “Birds of a Feather” in the  attribute.

You can check your code against style.css and header.php in lesson04/completed.

What You Have Learned
In this lesson, you have:

Examined the basic structure of Drupal, Joomla!, and WordPress (page 112)

Installed WordPress 3.0 in your local testing environment (pages 113–119)

Created a child theme based on the default WordPress Twenty Ten theme 
(pages 119–127)

Used Live View, the CSS Styles panel, and Code Navigator to style WordPress 
(pages 128–134)

Enabled site-specific code hints for WordPress (page 135)

Edited a WordPress template (pages 136–139)
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 5 What You Will Learn
In this lesson, you will:

See how a database stores information

Understand the principles behind efficient database structure

Explore the different data types stored in MySQL

Define the database table for a user registration system

Understand the effect of collation on how database records are sorted

Pick the appropriate database engine

Create MySQL user accounts and assign privileges

Import existing data from an external file 

Approximate Time
This lesson takes approximately 2 hours to complete.

Lesson Files
Media Files:

None

Starting Files:

None

Completed Files:

lesson05/states.sql

Lesson 4. Restyling a WordPress Site. Adobe® Dreamweaver® CS5 with PHP: Training from the Source, ISBN: 9780132117906
Prepared for jednet@mac.com, john gibbs
Copyright © 2011 David Powers. This download file is made available for personal use only and is subject to the Terms of Service. Any other use requires prior written consent from the
copyright owner. Unauthorized use, reproduction and/or distribution are strictly prohibited and violate applicable laws. All rights reserved.



141

LESSON 

Designing and Building 
Your Own Database

Having a content management system like WordPress build a database for you automatically 

is brilliant, but you’re forced to use the structure your chosen CMS dictates. Often, the best 

What’s not quite so easy is designing the database. Seemingly simple decisions can cause 

major headaches that are difficult to undo once the database has more than a few records. 

This lesson helps you avoid such mistakes and shows you how to build a database table for a 

phpMyAdmin provides a convenient web-based interface to MySQL.
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